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To select a single cell, simple click 

on it.  

 

To select a range of cells, click on 

one of the cells, and while 

holding your mouse button 

down, drag your mouse until all 

of the cells you would like to 

select are highlighted. 

 

Also you can use SHIFT+ Arrow 

keys, to select cell range. 

Just drag mouse pointer. 

SELECTING A CELL or A RANGE 
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To select the cells that are 

not together (non-

contiguous cells or non – 

adjacent cells) 
 

You can click the cells or range 

of cells by holding down the 

control-key.  

By the same way, you can select the non-

adjacent rows and columns. 
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To select the cells that are 

together (contiguous cells or 

adjacent cells) 

 
You can click the starting cell of 

the range and press and hold 

down the  shift-key, then click 

the finishing cell of the range.  

By the same way, you can select 

the adjacent rows and columns. 
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To select a row  

 
You can click on the Row Number. 

  

To select a column  

 
You can click on the Column Letter. 
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To select all the cells in a 

sheet  

 
You can click the this box. 

or 

press the CTRL + A 

  



CompuLab Central 

Last updated:  February 21, 2011 

MOVING AROUND  

IN THE SPREADSHEET  
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•  Press the arrow keys move the active cell one cell at a time to            

right, left, up and down or press enter key to move one cell down, tab 

key to right, Shift+Enter up, Shift+Tab to left. 

•  Similarly use the [PageUp] and [PageDown] keys to move the 

active cursor up or down a screen at a time.  

•  [Home] moves to the first column on the current row 

•  [Ctrl]+[Home] moves the first cell, A1 

•  [End], then [Home] moves to the first cell in the document 

•  CTRL + right arrow key, moves to the last cell in the same row 

•  CTRL + left arrow key, moves to the first cell in the same row 

•  CTRL + up arrow key, moves to the first cell in the same column 

•  CTRL + down arrow key, moves to the last cell in the same column 

 

MOVING AROUND IN A SHEET 
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•  First select a range 

•  Enter  to move to the bottom cell in the same range 

•  Shift + Enter to move to the upper cell in the same range 

•  Tab to move to the next cell in the same range 

•  Shift + Tab to move to the left cell in the same range 

MOVING AROUND IN A SELECTED AREA 
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• Click a cell to make it active cell 

• Just type what you wish 

• Pres the [ENTER] key or press an arrow 

key or click the enter button. 

ENTERING DATA INTO A CELL 

To cancel the typing just 

press the ESC key or click 

the Cancel button. 
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• Select the cell that you want to clear 

• Just press DEL or DELETE key. 

CLEARING CELL CONTENTS 
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Press the ALT + Enter at the end of the 

every line 

ENTERING MULTIBLE LINE OF DATA 

IN THE SAME CELL 
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• Select a range 

• Just type what you wish 

• Pres the CTRL + [ENTER] 

key. 

ENTERING SAME DATA INTO AN AREA (RANGE) 
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Now that you have entered data, you might 

need to alter the information. There are 

several ways to do this.  
 

Just to alter information in a cell, firstly 

click the cell with information, type your 

new data and press enter. Contents of the 

cell will replace with the previous one.  
 

To edit a cell, double-click on the cell or 

press F2 you want to edit, then the insertion 

point will appear inside the cell. You can 

use the arrow keys, backspace and delete 

keys to edit this cell as needed.  

EDITING CELL CONTENTS 

To enter into a cell 

double click on the cell. 

3A 



CompuLab Central 

Last updated:  February 21, 2011 

Sometimes you need to change column widths and row heights 

making wider and sometimes narrower. If text in a cell is wider 

than the column and there is information in the adjacent cell to its 

right, then the text information is truncated. 

RESIZING THE ROWS AND COLUMNS  

To adjust a column's width is to place your mouse pointer on the 

border between the column numbers. The mouse pointer will become 

a double headed arrow. Click and drag with the double-arrow until 

the column is the width you want. To adjust the row height, locate the 

mouse pointer on the border between the row numbers. 

1st WAY 
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RESIZING THE ROWS AND COLUMNS  

To adjust a column's width is to place your mouse pointer on the 

border between the column numbers. When you see a double headed 

mouse pointer. Double click the mouse to adjust the column width 

automatically to exact size. To adjust the row height automatically, 

you can follow the same method. 

2rd WAY 

Locate the mouse 

pointer on the border of 

the column headings 

when you see double 

headed arrow, double-

click the mouse to 

adjust the automatically. 
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The designer may hide some columns and rows (they do not need 

to view) in some case, for example, to make the report table with 

a shorter width to avoid scrolling left and right.  

HIDING AND UNHIDING THE ROWS AND COLUMNS  

In the picture, Column D 

is hidden. 
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HIDING AND UNHIDING THE ROWS AND COLUMNS  

Hiding rows or columns can be performed in two ways;  

     by selecting the row or column that you wish to hide, right 

clicking and selecting Hide.  

To hide the columns and rows, you can set their size to zero. 

2nd WAY 

1st WAY 
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HIDING AND UNHIDING THE ROWS AND COLUMNS  

    Lets unhide the column now.  

Step 1   Select the column range that contain hidden columns,  

Step 2   right-click and select Unhide option. 

    Notice that you have now unhidden column D.  

As mentioned above, you can also perform the hide/unhide operation 

by right clicking and selecting either Hide or Unhide from the 

shortcut menu. This is my preferred option, but it is up to you 

which one you use.  

Step 1 Step 2 
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COPYING AND MOVING 

CELL CONTENTS 
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When we Copy data from one cell to another, we are making a 

duplicate of the cells content.  
 

When we Cut data from a cell we are actually moving it from its 

current location to a new location.   
 

Pasting is placing either the Cut or Copied data in its new 

destination. 

TO COPY,  USE COPY AND PASTE COMMANDS. 

TO MOVE, USE CUT AND PASTE COMMANDS. 

 

1st METHOD BY USING COPY, CUT, PASTE COMMANDS 
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COPYING 

There are many ways that we can Copy in Excel, the way that you 

do it is purely optional and should be the way you are most 

comfortable with.  

 

Make sure you have selected the cell which you want to copy. Then 

you can either: 

 

i)   Right click on the cell and from the Shortcut menu select Copy.  

ii)  Push Ctrl + C on your keyboard  

iii) Select the Copy button from the Home ribbon menu.  

iv)  Hold down Ctrl key, then Use the Drag and Drop operation. 
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CUTTING 

Again, as with most options in Excel, there are a multitude of ways 

to Cut a cell.  

 

Make sure you have selected the cell which you want to cut. Then 

you can either: 

 

i)    Right click and select Cut from the Shortcut menu  

ii)   The Cut button from the Home ribbon menu (the pair of 

scissors)  

iii) Press Ctrl + X on your keyboard 

iv)  Use the Drag and Drop operation. 
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PASTING 

After using the copy or cut command, to finish copying or moving 

data you should use the Paste command. 
 

Now select any other cell and either: 
 

i)   Right click on the cell and from the Shortcut menu select Paste  

ii)  Push Enter on your keyboard  

iii) Push Ctrl + V on your keyboard 

iv) Select the Paste button from the Home ribbon menu .  

 

In the second way by pressing Enter you will CLEAR the Clipboard 

after it has Pasted in the data. You will notice with the other four 

methods that the contents the cell stays on the clipboard.  This means 

that we could select other cells and continue pasting as much as we 

like using any of the above methods other than using Enter on our 

keyboard.  
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2ND METHOD USING DRAG AND DROP METHOD 

FOR COPYING AND MOVING 

There is another method that can be used to Copy or move, this is 

called Drag and Drop, and is possibly the fastest method if you 

only intend to Paste the data into one destination as opposed to 

various.  

For this method, again select the cell which you want to copy or 

move, hold down your Ctrl key to copy or don’t press any key to 

move, and locate your mouse on the border of the cell and drag in 

the desired location then simply release the mouse button. 

 

If you also hold down your Alt key whilst doing this, you can 

change sheets by dragging the copied data over the sheet name 

tab that you wish to copy or move it to.  



CompuLab Central 

Last updated:  February 21, 2011 

The last method of Copying and Pasting data is 

to select the cell you wish to Copy, right click 

on any cell border and holding down the right 

mouse button drag to any destination cell, then 

release the mouse button. Excel will display 

another Shortcut menu, giving you various 

options. Some of these options are the same as 

in the Paste Special dialogue box so we will 

only look at the last four options of this Shortcut 

menu, the Shift Down and Copy and the Shift 

Right and Copy. 

Again, type any value in cell A1, then type any value in cell D1. Select cell A1 and right click on any cell 

border with the right white arrow showing. Holding down your right mouse button, drag A1 to cell D1, 

then release the mouse button and select Shift Down and Copy. You will notice that Excel shifts down the 

value of cell D1 and places it into cell D2 before it Pastes in the data from cell A1. Delete the contents cell 

D2.  

Again, select cell A1, right click on any cell border, select cell D1 again and release the right mouse 

button. This time select Shift Right and Copy. This has now done the same as the Shift Down and Copy 

option,  except as the name implies, it has shifted the data in cell D1 to the right before pasting in the 

contents of cell A1. 

DRAGGING THE CELL BY RIGHT-CLICK 

3RD METHOD 
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USING PASTE SPECIAL 

By default, when you Copy and Paste the content of any cell(s), 

Excel will Paste all cell formatting. We can, however, use what is 

called Paste Special to nominate the attributes of the copied data 

we wish to Paste. 
 

To do this, again Copy the cell(s) in any of the above methods 

(except Drag and Drop). Now select your destination cell and  
 

go to Home ribbon menu > Open Paste option > select Paste 

Special  

or right click and select Paste Special from the Shortcut menu.  
 

This will display the Paste Special dialogue box.  In this dialog 

box under the heading Paste, there are different options that can 

be applied, the default is All, which is exactly the same as using 

any of the Paste methods described above.  
 

The other options are: 
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PASTE SPECIAL OPTIONS 
Under the heading Operation 

•All 

•Formulas 

•Values 

•Formats 

•Comments 

•Validation 

•All except borders 

•Column Widths 

•Formulas and Number 

Formats 

•Values and Number Formats 

 

Under the heading Operation 

None 

Add 

Subtract 

Multiply 

Divide 

Paste Link 

 

To see Paste Special dialog box; after copy or 

cut, select Paste Special from Edit menu or Right 

click and then select Paste Special option.  
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Formulas 

This option would apply only if the cell we copied contained a 

formula. What this means is instead of the formatting and other 

attributes of the cell being Pasted, only the formula itself will be 

Pasted. To put this into some sort of context, imagine the cell 

containing any formula to be copied where the background colour 

of the cell is bright yellow, using Formulas would not Paste the 

background colour of the cell, just the formula.   

Values 

Again, imagine a cell being copied that contained a formula 

where the result of that formula was the number 20 (or any other 

number). Choosing the Values option, would mean that we would 

only be Pasting the result of the formula into the destination cell 

and not the formula itself. 

PASTE SPECIAL OPTIONS 
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Formats 

Using this option means you will not be Pasting the contents of 

the cell, but only the formatting.  Again, imagine a cell with a 

yellow background containing the number 100 (or any other 

data). On selecting this option, the destination cell would end up 

having a yellow background, but not the number 100. 

Comments 

This option applies to Cell Comments which will be covered in a 

later lesson. 

Validation 

This option applies to Cell Validation which will be covered in 

the Level 2 course. 

All except borders 

Means all the cell contents and formatting excluding (without) 

borders would be Pasted. We will be looking at borders later. 

PASTE SPECIAL OPTIONS 
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Column Widths 

Means no content or formatting will be Pasted, except for the 

width of the column that the data was copied from. 

 

Formulas and Number Formats 

Using this option will Paste only formulas and all number 

formatting options.  Number formatting will be covered later. 

 

Values and Number Formats 

This will Paste only values and all number formatting options. 

 

PASTE SPECIAL OPTIONS 
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None / Add / Subtract / Multiply / Divide 

 

None 

This is exactly as the name implies and means None of the 

options under the heading operation will be applied. Even if this 

option and all the other options under Operation are not checked, 

which is the default, None would still apply. 

 

The next part of the dialog box has a heading Operation.  

 

In order to demonstrate the options under this heading, type the 

number 2 into cell A1 and the number 10 in cell A2. Copy cell A1, 

then select cell A2 and again right click and select Paste Special.  

PASTE SPECIAL OPTIONS 
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Add 

Select the option Add and click OK. You will notice that Excel 

adds the copied number (in this case 2) to the value of the 

destination cell (which in this case is 10) to end up with a total of 

12. In other words it adds a copied number to the destination cell. 

Subtract 

Again, to see this repeat the coping of cell A1 and again select 

cell A2 and right click and select Paste Special. This time, select 

Subtract and cell A2 will be have the number 2 subtracted from 

its value. 

Multiply 

It Multiplies the destination cell by the value of the copied data. 

Divide 

It Divides the destination cell by the value of the copied data. 

PASTE SPECIAL OPTIONS 
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The other two options work in the following way: 

Skip Blanks 
Type any number into cell A1, any number in cell A2, leave cell A3 blank and 

again type any numbers in cells A4 and A5. Now in cell B1 to B5, type any 

numbers so that all cells are filled. Now select cell A1 holding down your left 

mouse button, drag down until cells A1 to A5 are highlighted.  Right click 

anywhere within A1:A5 and select Copy, select cells B1 to B5 in the same 

way, right click and select Paste Special. Select the bottom option Skip Blanks 

and click OK. What you will notice, is that Excel did not Paste the empty cell 

of A3 over the top of the value in B3. In other words, as the name implies it 

skipped the blanks.  

Transpose 
While you still have five values in cells B1:B5, highlight these cells, right click 

and select Copy, then select cell D1 choose Paste Special and select the option 

Transpose. Click OK. You will notice that Excel will have Pasted your rows of 

values into columns. In other words, instead of cells D1 to D5 having the 

values Pasted into them, you should have D1 to H1. 

PASTE SPECIAL OPTIONS 
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Paste Link 

The very last option is the Paste Link button located at the 

bottom right of the Paste Special dialogue box. To see this work, 

type any value in cell A1, Copy this cell then select any blank 

cell, right click, choose Paste Special and click Paste Link. You 

should notice that your destination cell will be showing the value, 

the same as your copied cell. If you look in your Formula Bar 

(located under your toolbars) you will see Excel has placed what 

is known as an Absolute Cell Reference Formula, ie; =$A$1.  It 

is the dollar symbols that have made the reference absolute. We 

will be discussing Absolute and Relative references in detail in a 

later lesson. 

PASTE SPECIAL OPTIONS 
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DELETING CELL(S), ROW(S) AND COLUMN(S) 

DELETING CELL(S) 

You can delete cell(s) in Excel very easily. 
 

•  Select the cell that you want to delete 

•  From the Edit menu choose Delete or right-click and 

select Delete option Excel will display a dialog box asking 

how you want to shift the remaining cells.  

•  Specify whether you want to shift cells.  

•  Click OK.  

DELETING ROW(S) AND COLUMN(S) 

Similarly to delete row or column 

select entire row or column and 

follows the same rules to delete cell(s).  
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1 1 

2 2 

3 3 

4 4 

5 

6 

7 

8 

5 

6 

7 

A B C D E F G H I J K L 

Step 1 B4 Cell will be deleted. 

Step 2 Other cells will shift up 

Step 3 A new cell will be added to                    

,          the  end of the column. 
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INSERTING CELL(S), ROW(S) AND COLUMN(S) 

When working in Excel, there are times that you may need to 

insert an entire new row, an entire new column or only a 

single cell.  Although the term Inserting gives the 

impression that you are actually adding another row, column 

or cell, you are in fact NOT. You may remember that in the 

first lesson we mentioned the fact that Excel has 256 

columns, 65,536 rows and 1,677,216 cells per worksheet. 

These numbers are fixed, so technically we cannot add 

more.  

So when you insert a cell, row or column What Excel will 

do? Excel will shift the cell, row or column and will add the 

new cell, row or column into the this space and then will 

delete the last shifted cell, row or column. Total number of 

the cell, row and column will remain same. 
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How To Insert a cell 

You can insert one cell in Excel very 

easily. 

1.Select the cell near where you want 

to insert the new cell.  

 

2.From the Insert menu choose Cells 

or right-click and select Insert. Excel 

will display a dialog box asking how 

you want to shift the remaining cells.  

 

3.Specify whether you want to shift 

cells.  

 

4.Click OK.  

How To Insert a Entire 

Column or Row 

An inserted row goes above the row you 

select, while an inserted column goes to 

the left of the selected column. 

 

1. Select the row to the right or column 

above where you want to insert a new 

row or column. You can use the column 

and row heading buttons to select entire 

columns and rows.  

 

2. Right click on the column or row 

heading and Click Insert.  

 

4. You do not need to specify where to 

shift cells. 

If we want to insert more than one cell, row or column at a time, we simply select the 

appropriate number of rows, cells or columns before using Insert either via the menu option or 

the right click Shortcut menu. For example, if you select four entire rows, then right clicked 

and selected Insert, you would be inserting four new empty rows. 
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Finally, just to stress my point that we are not technically adding 

more rows, columns or cells, go to cell IV1, by either typing the 

cell reference in the Name box to the immediate left of the 

Formula Bar, or push F5 and type IV1 in the Reference: box. 

Type any data into cell IV1 and now push Ctrl + Home to take 

yourself back to cell A1. Select any entire column, right click 

and choose Insert.  You will see that Excel will display a 

warning letting you know that it cannot shift non blank cells off 

the Worksheet. This is because we have data in cell IV1. So, as 

you can see, Excel isn’t really adding an extra column, it is 

simply moving the last one off the Worksheet before inserting a 

new one.  Press OK to cancel out of the warning box. 
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WORKSHEET 
  

OPERATIONS 
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All Workbooks must contain at least one Worksheet. The maximum number of 

Worksheets a Workbook can contain is limited only by the available memory of the 

PC. As a default, Excel places three blank Worksheets in front of you. Each one of 

these has the default name Sheet1, Sheet2, Sheet3 at the bottom.  

 

NOTE: You can change the default of three blank Worksheets by 

going to File >Options/General and enter the number of the sheets 

in the box “Include this many Sheets in new workbook”. 

 
Each separate rectangle within the Worksheet is called a Cell. You will notice letters 

across the top of your Worksheet. These are the names of the columns and go from 

A through to IV. The numbers down the left hand side of your sheet of graph paper 

symbolize row headings labeled with numbers.   

WORKSHEETS 
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INSERTING WORKSHEET 

Adding new Worksheets to a Workbook can be done 

in a number of ways.  The most common are: 

 

• click “Insert Worksheet” button 

 

•Right click on any Sheet name tab and select Insert 

and then select Worksheet.  

• Shift + F11 
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DELETING WORKSHEET 

The logical opposite to inserting Worksheets is Deleting them. 

This can be done in any of the following ways. 

Right click on the Worksheets name tab and select Delete or 

Whichever method we use, Excel will display a 

warning message letting us know that the deletion 

cannot be undone.  

In Home tab, select Delete and click Delete Sheet 
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NAMING WORKSHEETS 
To name a Worksheet we can do so with any of the most methods 

below: 

•  Double click the Worksheet Name tab. This will allow you to 

now type the name. Once finished, push Enter or click any cell.  

•  Right click on the Worksheet Name tab and select Rename 

from the shortcut menu. Then type the name and hit Enter or click 

somewhere else on your Worksheet.  

 

You can give any name to your worksheets. The only 

restrictions we have with Worksheet names is: 

•  They cannot exceed 31 characters.  

•  They cannot contain the following characters: \ / ? * [ ].  

•  The name cannot be the same as another Worksheet in the 

Workbook.  
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MOVING OR COPYING A 

WORKSHEET 

COPYING A WORKSHEET 
 

Select the Sheet you want to copy then left click on the name tab 

and holding down the Ctrl key drag it to one side, then release.  

 

MOVING A WORKSHEET 
 

Simply click the Worksheet Name tab, then holding down the 

mouse button drag it to it's new position and release.  

1st WAY 
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   The other method is to use the Move or the Copy dialogue box.  

•   Right click on the Worksheet Name tab and select Move or 

Copy 
 

•You will see the Move or the Copy dialogue box. 

2nd WAY 
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You will see also on this dialogue box a To 

book: box with a small drop arrow to the 

right. The selection in this box will 

determine where our sheet will be moved or 

copied to.  The default name in this box will 

be the active Workbook name (the current 

Workbook we are in).  There will also 

always be another choice, if we click the 

drop arrow. This is (new book), if we choose 

this option Excel will automatically make a 

new Workbook for the sheet to be moved or 

copied to. Within this box will also be the 

names of any other open Workbooks, should 

there be any.  

Directly below the To book: box is the Before sheet: box. Our selection in this 

box will decide which position our sheet will be moved or copied to. Last of all is 

the Create a copy checkbox.  If we check this box Excel will create a copy of our 

moved Worksheet. In other words our original sheet will remain where it is and a 

copy of it will be moved to our chosen location.  If we leave it unchecked (which is 

the default) the Worksheet will be moved and not copied.  
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SELECTING MULTIPLE WORKSHEETS 

To select the adjacent worksheets 

Click the starting worksheet tab, hold down the SHIFT key then 

click the last sheet in your range you wish to select. 

 

 

To select the non-adjacent worksheets 

Click the first worksheet tab, hold down the CTRL key then click 

the other worksheet tabs one by one. 
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CHANGING THE ACTIVE WORKSHEET 

•   Click the worksheet tabs 

 

•   Use worksheet navigation 

buttons 

 

•   Use CTRL + Page up or  

           CTRL + Page down keys. 


